
Fluorescence microscopy & Single 
Molecule Localization Microscopy  
Please read the overview and the introduction before the experiment starts and answer the “Pre-lab 
questions” at the end of the introduction 

Overview 

In this module, we will study the application of fluorescence microscopy in biophysical research. We 
will see what advantages fluorescence microscopy has, the limit of resolution of optical microscopy and 
how single molecule localization microscopy can overcome this limit. For these purposes, you will image 
some biological specimens, understand how a fluorescence microscope works, build your own microscope 
and image the specimen with both regular and super-resolution fluorescence microscopy. 

Introduction to fluorescence microscopy and single molecule localization microscopy 
  

Absorption of light and subsequent re-emission (which happens nearly simultaneously, typically a few 
nanoseconds) by organic and or inorganic molecule is called fluorescence. Only a few molecules actually 
fluoresce, but those that do and can be placed at a position of interest, are extremely valuable. Watching 
where a labeled biomolecule is, or moves around, can be illuminating. When looking at the object through 
a microscope, fluorescence microscopy has become an essential technique in biological sciences due to 
its availability of high contrast and specificity.  

The basic function of a fluorescence microscope is to irradiate the specimen with a specific band of 
wavelengths, and then to separate the much weaker emitted fluorescence from the excitation light (Fig. 
1). In a properly configured microscope, only the emission light should reach the detector so that the 
resulting fluorescent structures of the specimen are visualized with high contrast against a dark (almost 
0) background. The limits of detection are generally governed by the darkness of the background, and the 
brightness of the fluorescence. Under ideal conditions, it is possible to detect a single fluorescent molecule, 
provided that the background and detector noise are sufficiently low. (One real consideration, is that the 
excitation light, necessary to induce the fluorescence, is typically 105 -106 times brighter than the emission, 
so getting rid of this, is a very important.) 

Emission (Green light) 

Excitation (blue light) 

~ 1 nanometer 

Figure 1. Absorption and fluorescent emission of a molecule. Excitation (blue) light is absorbed by the 
molecule and emitted (green) from the molecule. 



Optical microscopy, i.e. where the wavelength of excitation or emission is roughly 400-750 nm, 
including fluorescence microscopy, has limitation of its resolution defined as λ/2NA, called the 
diffraction limit of light where λ is the wavelength of the light and NA is the numerical aperture --which 
is the range of angles over which the lens can collect the light-- of the detection objective of the 
microscope. While the fluorescent object is only in nanometer in size or-so, it’s emission (i.e., its 
fluorescence light) is ~ 250 nm. Why? Even though the light was emitted from a point source, at the 
image plane wavelets from different points of the wave front undergo interference, forming blurry Airy 
distribution of light which is ~λ/2.(See the interactive tutorial:  
http://micro.magnet.fsu.edu/primer/java/imageformation/airydiskformation/index.html and “What is 
resolution”, which can be found on the web page  of Physics 498EBP) 

This limitation defines the minimal dimension of the structure one can distinguish in the specimen 
by using optical microscopy, which is about 250 nm for visible light. 

 
Figure 2. Principle of single molecule localization (FIONA). The figure shows a point spread function (PSF). The width of the PSF is 
blurred out (~250 nm) but one can estimate the center of the PSF much more accurately than the width. 

How can we go from something whose emission is blurred out (to ~ 250 nm), to much smaller. If we 
know that there is a single molecule present, we can figure out where the center is with much better 
accuracy than the blurred image of the molecule.  

FIONA (Fluorescence Imaging with One Nanometer Accuracy) is a powerful technique that can be 
used for making ~ nanometer accuracy localization of molecules. The premise behind FIONA is that one 
can measure the center of a point-spread function (PSF) much more accurately than the diffraction limit, 
provided enough photons can be collected. For FIONA, fluorescence from single dye molecules are 
recorded by a camera. The recorded images show bright spots which can be modeled as Gaussian 
functions (Figure 2). The accuracy of a measurement of the position (center) of the molecule is given by: 
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where N is the number of photons collected, s is the width of the distribution in either the x or y 
direction, a is the pixel size of the camera (actual pixel size of the camera divided by the magnification of 
the system), and b is the standard deviation of the background. The first term under the square root 
describes the photon noise (shot noise), the second is the effect of the finite pixel size of the camera, 

http://micro.magnet.fsu.edu/primer/java/imageformation/airydiskformation/index.html


and the third is the background noise. For a pixel size of approximately 100 nm, the photon noise term 
dominates therefore the accuracy of localization is ~ s/2√N = λ/2NA√N. By collecting 5,000-10,000 
photon counts per second, one can localize a fluorescent molecule to within a nanometer. 

 
Figure 3. Two molecules located further than diffraction limit (left, resolved, shown at >~250 nm) at about Rayleigh criterion 

(middle, diffraction limit) and closer (right, unresolved). 

The above depends on seeing a single molecule. What if we have two (or more molecules) within the 
diffraction limit? In Figure 3, you can see two molecules located at different distances from each other. 
When they are far enough (> diffraction limit) it is possible to distinguish two molecules. However, when 
they are closer than the diffraction limit (known as the “Rayleigh Criterion”), two molecules become 
unresolvable. How can we resolve multiple molecules located very close to each other?  

  

 
Figure 4. Principle of single molecule localization microscopy to get super-resolution. Here, the molecules within the diffraction 
limit of light are switching on stochastically, so that every molecule fluorescing can be localized at different time points. The 
collection of every localization results in the super-resolution image of the structure.  

 
In Figure 4, multiple fluorescent molecules are located within the diffraction limit. The image of the 

molecules is shown as a blurred image and it is not possible to visualize the structure beyond the limit 
(left). However, using photochemical properties of the molecules we can make the molecules blink so that 
only a few molecules far from each other can be detected at a time. By detecting the molecules randomly 
blinking at different time points, one can localize each molecule with higher localization accuracy using 
FIONA (middle). By repeating this over time until all the molecules in the specimen are detected, one can 
get the position information of every fluorescent molecule of the sample with ~10 nm localization 
accuracy. The collection of the localization of the molecules, finally show the structure of specimen with 
the resolution beyond the diffraction limit.  
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Pre-lab questions (answer the questions and get them checked by TA before you start the experiment) 
1. What is fluorescence? 
2. When two molecules are separated by 300 nm, what is the maximum wavelength to distinguish 

them? 
3. A molecule is moving with 10 nm discrete step. To distinguish the step size of the molecule, how 

many photons do you need to collect for each step? 
 
1.  Fluorescence vs. Bright field (Day 1 of week 1) 

First, you will image some specimens using fluorescence and bright field microscope to see the 
difference and advantage of them. You will use the setup built by the TA (and then you will build your own 
in next session!). 

 
Samples 

- Immobilized fluorescent beads: 40 nm, 100 nm, 200 nm, and 4 µm diameter 
- Fluorescently labeled cell (HeLa cell stained by anti-αtubulin-Alexa647) 

 
Image acquisition 

0. When the laser is on, wear safety goggles. 
1. Turn on the computer and start FlyCapture software for the camera. 
2. Put a drop of immersion oil on the objective lens. 
3. Place the sample on the stage. 
4. Using z-focusing stage, raise the objective so that the immersion oil touches the glass coverslip. 
5. Cover the sample with black box. 
6. Turn on the laser. 
7. Using z-focusing stage, focus the sample to see clear image of the sample. 
8. Take images of sample and save them with proper name. 
9. For comparison, take bright field image of each sample as well. 

a. For bright field image, turn off the laser and take off the block box from the sample. 
b. Using flashlight of your smart phone, take images of the samples. 

10. You will also take STORM image using TA setup. The detail instruction is in Session 3. TA will give 
on site instruction. 

11. Each group member needs to take one set of images. 
12. After all images are taken, wipe the objective lens with lens cleaning paper and methanol. 

 
Analysis 

Use the images taken in the previous session to answer the lab report questions. Image J is a good 
tool for image analysis. For the analysis, refer to the instruction below. 
 
Instruction for measuring size 

1. Start Image J and drag and drop your image file on Image J window to open the file for analysis. 
2. First you need to set the scale (pixel size) of your image. 

a. Go to “Analyze -> Set Scale”  
b. Enter Distance in pixels: 1, Known distance: 0.0552, Pixel aspect ratio: 1.0 and Unit of 

length: um. 



 
c. Click OK. 

3. You can adjust brightness and contrast of the image by “Control+Shift+C” 
4. Choose the object of which size (diameter, width or thickness) you want to measure. 

5. Click   icon to select cross section of your target. 
6. Click and draw a line across the object of your interest. 

 
7. Hit “k” to measure line profile. Image J will show the following plot. 

 
8. Click “List” to see the value. 
9. For Gaussian fitting of the value copy the plot values. (Control+c) 
10. Go to “Analyze -> Tools -> Curve fitting” 
11. Paste the plot value and choose “Gaussian” for fitting curve. 
12. Click “Fit” then Image J will show you the fitting parameters. 

 
 
Instruction for using ThunderSTORM for analysis 

Here you will use Image J and Origin for the analysis. 
 

1. Open an image file using Image J. 
a. File -> Import -> Image sequence, go to the folder of your images, click the first file, and 

click open. 
b. Put the parameters according to the image below. Scale images: 50% will 2x2 bin your 

image with averaging pixel value. 



 

2. Plugins -> ThunderSTORM -> Camera setup. Enter the parameters according to the picture 
below. Photoelectrons per A/D count will vary depending on the gain value you use (Refer to the 
table). Base level [A/D counts] value will depend on the background count of your image. Move 
the cursor to dark regions of the image to measure the background.  

 

 
 
 
 
 
 
 
 
 
 
 

3. After setting up the camera, go to Plugins -> ThunderSTORM -> Run Analysis/ and enter the 
values according to the picture. 

Gain (dB) Photoelectrons per A/D count 
(w/o binning) 

Photoelectrons per A/D count 
(2x2 binning) 

0 0.27 1.08 
10 0.085 0.34 
20 0.027 0.108 
30 0.0085 0.034 
40 0.0027 0.0108 
48 0.0011 0.0044 



 

4. Click “Preview”. You should be able to see red dots overlapping on the beads. If there are more 
or less red dots, go back to the camera setup and adjust the base level accordingly (increase if 
there are more red dots than the beads, otherwise decrease). 

5. After making sure that the preview looks fine, click “Ok” button next to the “preview” button. 
You will get a screen similar to the one below. 



 

6. Click the “plot histogram” button and then plot histograms for the parameters “intensity” 
(photon count per point per frame), “offset” (background photon count) and “uncertainty” 
(localization precision). Compare these parameters for different sets of data. 

 
 
 
2. Building a simple fluorescence microscope (Day 2 of week 1 and week 2)  
 

To achieve its function, a fluorescence microscope has number of optical components as illustrated 
in Figure 4. Figure 4 is a schematic diagram of a very simple epi-fluorescence microscope. In the first 



session, you will build a simple fluorescence microscope which has capability of single molecule 
localization microscopy (SMLM) and understand the role of each optical component. 

When the microscope is built, you will need to characterize your setup. Before you get the super-
resolution, we want to know the diffraction limit of the system. By looking at the sample with the sub-
diffraction limit size (40 or 100 nm fluorescent beads), you will be able to tell what the limit of the 
resolution of the system is. Then by using the technique called Fluorescence Imaging with One-Nanometer 
Accuracy (FIONA), you will learn that you can localize the position of the detected molecule with the 
accuracy that is higher than the diffraction limit.  

For high quality of SMLM image, it is also important to have high signal-to-background ratio (SBR) or 
signal-to-noise ratio (SNR). Here, we will learn how the conditions and the parameters for the image 
acquisition affect the result of the molecular localization.  

 
Figure 5. Schematic diagram for the simple SMLM setup. 

 
Questions before you start building! 
 

Before building the setup, let’s see the role of each optical component. You will need to answer these 
questions: What is the function and the role of each optical component in the microscopic system? (These 
questions will come again at the lab report question 3.) 
 

• Major components 
Laser: 
Dichroic (dichromatic) filter (beam splitter): 
Emission filter: 
Objective lens: 
Tube lens: 
Lens 1&2 (Beam expander): 
Lens 3 (as Kohler lens): 



• Minor things 
ND filter: 
Diffuser: 

 
Building a simple epifluorescence microscope 

 
Figure 6. The 3D CAD schematic of the SMLM setup and the corresponding detailed list of components is shown in Table 1 

Module Item # Item Description 
Light Source 1 Laser module Wave length: 638 ± 3 nm, Maximal power: 

500 mW, Output stability: 5%, Beam size: 5 
mm, Divergence: <1.5 mrad, M²: <1.6, 
TTL/Analog power control 

2 ND filter Rectangular Step ND Filter, 10 mm wide, 
OD: 0.3 - 2.0. 
You need to use sliding holder to assemble 
it on the post. 

3 Lens f=100 mm, Ø1" Achromatic Doublet, SM1-
Threaded Mount, ARC: 400-700 nm 

4 DC motor 6V 250mA Brushed DC Motor, No-load 
speed: 9100 ± 1800 rpm 
It will be held by the clamp holder 

5 Engineered diffuser Round 1 inch, Divergence angle: 5.48º 
It is glued on the motor shaft. 

6 Lens f=100 mm, Ø1" Achromatic Doublet, SM1-
Threaded Mount, ARC: 400-700 nm 

7 Lens f=200 mm, Ø1" Achromatic Doublet, SM1-
Threaded Mount, ARC: 400-700 nm 

8 Lens Mount Lens Mount with Retaining Ring for Ø1" 
Optics, 8-32 Tap 



9 Optical Post Ø1/2" Optical Post, SS, 8-32 Setscrew, 1/4"-
20 Tap, L = 6" 

10 Post Holder Ø1/2" Post Holder, Spring-Loaded Hex-
Locking Thumbscrew, L = 4" 

Microscope 11 Sample holder Self-designed sample holder with aperture 
of 20 mm 

12 XY translation stage X-Y Travel Distances: 75 x 56mm, Active 
Area: 37.6mm in diameter 

13 Objective lens 100X (Oil) Infinity-corrected Plan Fluor 
Objective Lens, NA = 1.3, tube length: 160 
mm 

14 Z-focusing stage SM1 Zoom Housing for Ø1" Optics, Non-
Rotating, 4.1 mm Travel 

15 Filter cube Kinematic Fluorescence Filter Cube, 30 mm 
Cage Compatible, 1/4"-20 Tapped Holes 

16 Dichroic mirror 660 nm edge BrightLine single-edge dichroic 
beam splitter 

17 Emission filter emission filter for Alexa-647 
18 Spacer SM1 Lens Tube Spacer, 1" Long 
19 Tube lens f=100 mm, Ø1" Achromatic Doublet, SM1-

Threaded Mount, ARC: 400-700 nm 
20 Spacer SM1 Lens Tube, 2.50" Thread Depth, One 

Retaining Ring Included 
21 Thread adapter Adapter with External C-Mount Threads and 

Internal SM1 Threads 
22 Camera Sony IMX265 sensor, 2048 x 1536 3.45 μm 

pixels, 71% QE, 2.89e- read noise, USB3.0 
23 Optical post Ø1/2" Optical Post, SS, 8-32 Setscrew, 1/4"-

20 Tap, L = 8" 
24 Microscope base Aluminum Breadboard 8" x 8" x 1/2", 1/4"-

20 Taps 
25 Vibration isolating feet Ø27.0 mm Sorbothane Feet, Internal 1/4"-

20 Mounting Thread, 4 Pieces 
Optical Table 26 Breadboard Aluminum Breadboard 12" x 36" x 1/2", 

1/4"-20 Taps 
Miscellaneous - Alignment target Fluorescent target with RMS thread 

- Thread adapter Thread adapter for the objective lens (RMS 
to SM1) 

- Fluorescent card  
 

The goal of this session is to “align the laser” for the microscope system. For the proper 
“alignment”, there are two specific checkpoints for this session. 

- The laser should be “collimated” after the beam expander. 
o What is “collimation”? and how would you check whether the beam is collimated? 

- The profile of the beam should be uniform (you can see the profile after the beam expander 
by using fluorescence detection card. 

- The laser should be focused at the back focal plane of the objective lens.  



Before you start: 
- You should wear safety goggles when the laser is ON. Even if you are using low-power laser, 

focused laser can damage your retina or skin. 
- You should work with the high-power laser ONLY IN THE PRESENCE OF TA. This is for your safety. 
- You should wear gloves to prevent the contamination of optical elements: lenses, objective lens, 

filters. Fingerprints or oil from skins can damage or degrade the performance of the elements. 
General workflow for this session:  

1. Place the breadboard on the flat and stable place. 
2. Set the heights of the parts (posts) as the same as the height of the aperture of the filter cube. 
3. Place and assemble the parts accordingly to get the beam “collimated” after the beam expander. 
4. By using diffuser, make the beam profile uniform. 
5. Using Kohler lens (condenser lens) focus the beam at the center of the back focal plane of the 

objective lens (using fluorescence target). 
6. Assemble the objective and start imaging test samples. 

- Samples: fluorescent beads with diffraction-limited size (40 nm, 100 nm or 200 nm given by TAs) 
7. The points to check:  

1) With bead samples check whether you can see diffraction limited PSF and whether it’s 
symmetric. 

2) Homogeneous illumination intensity over wide enough area (~ ¼ of the whole camera area). 
 

 

 
3. How does SMLM achieve “super-resolution?” (week 3) 
 

In the second session, you will image a biological specimen, mammalian cell whose actin filament (one 
of cytoskeletons in cells) is fluorescently labeled, with super-resolution. In the previous sessions, you 
learned the diffraction limit, and how to overcome the limit in terms of localization of single molecules 
separated more than the diffraction limit. Here, in addition to the localization, you will learn how to get 
super-resolution using stochastic photo-switching of fluorophores. 
  
  
STORM image of cytoskeleton (microtubule or actin)  
  
Preparation of the specimen (HeLa cells labeled by anti-tubulin-Alexa 647 (for microtubule) or 
phalloidin-Alexa 647 (for actin)) - done by TAs. 

1. Coat a glass bottom dish with poly L lysine (PLL) for 30 min 
2. Wash the dish with PBS or MBG water and put 1/20 dilution of 200 nm gold particle and incubate 

for 3 hrs. 
3. After the incubation, wash with PBS or MBG water. For better cell adhesion, coat PLL for another 

30 min before the seeding. 
4.  Seed the cell on the dish. In general, 1 ml of cell culture from the 25 cm2 culture flask is good. 

Culture until cells settled on the surface. 
5. When cells are ready, take out the culture media and wash with PBS for 1 time. Fix the cell with 

4% paraformaldehyde (PFA) for 10 min. 
6. Wash with PBS for 2 times, add 0.5% Triton-X and incubate for 10 min. 
7. Wash with PBS for 2 times and incubate the cell in 5% BSA in PBS for 1 hr at 37C, or overnight at 

4C for blocking non-specific binding. 



8. After blocking, incubate with 1/200 diluted anti tubulin-Alexa647 or 0.8 U/100 ul phalloidin-Alexa 
647 in blocking buffer for 30 min. 

9. Wash the cell with PBS for 2 times. 
10. Prepare the imaging buffer. Students will test 3 different imaging buffer conditions. 

Imaging buffer: 
 Oxygen scavenger Thiol 
1 - - 
2 + - 
3 + + 

Oxygen scavenger: Gloxy (1 mg/ml glucose oxidase, 0.15 mg/ml catalase, 5 mg/ml glucose) 
Thiol: 10-20 mM MEA. 
In PBS 

11. Add the imaging buffer to the sample and Image the cell immediately. Reducing condition of 
imaging buffer can destabilize the structure in the specimen, therefore in order to image fine 
structure, the sample should be imaged within a few hours. 

  
Image acquisition 

1. Wear the safety goggles always. 
2. Put a drop of immersion oil on the objective lens. 
3. Place the sample on the stage. 
4. Connect the camera to the computer through USB connection. 
5. Start the operation software (Point Grey Fly capture). 
6. Focus to the sample by rotating z focusing stage. 
7. By moving the sample stage find appropriate region of interest (ROI). 

a. The ROI should include well-labeled cells and a few gold particles attached on the glass 
surface for the drift correction. 

 

Figure 7. Example of a good ROI. Attached gold particles are highlighted by the white square. 

b. Since cells have 3-dimensional structure, the structure of actin filament varies between 
cells. Focus on the gold particle for the drift correction and find a nice structure of actin 
filaments. 



8. Set the parameters for imaging. Here is one example for the image acquisition. You may vary the 
parameters for better Signal-to-Background Ratio (SBR). Make sure the pixel value is not 
saturated. 

a. Frame rate: 25 fps 
b. Exposure time: 40 ms 
c. Gain: between 10-48 dB depending on the signal 

9. You will see quick photobleaching of the dye as rapid decrease of the signal. In a few seconds you 
will be able to see random blinking of single Alexa 647 molecules. 

10. Once you observed the blinking of the molecules, start recording images. 5,000-10,000 frames will 
be enough number. 

 

Session 4: Analysis of STORM image 
Here you will use an Image J plugin, “ThunderSTORM” for the analysis of STORM image. Refer to 

step 2 for opening files and setting up the camera. 
1. Follow the step 1-3 in the session 2 to open the image. Use 50% (2x2 binning). 
2. Crop an ROI with 1 gold particle and duplicate (Ctrl+Shift+D) the ROI (check Duplicate stack). You 

can save the image as a separate image for the drift correction step (step 5). 

 
3. Go back to the original STORM image. Run analysis with the image. 
4. After analysis is done, export the sheet in your data folder. It will be saved as **.csv format. 
5. Drift correction 

1) Open the image file of the gold particle you chose in step 2.  
2) Run ThunderSTORM analysis with the image. 
3) Export the result as “filename_Drift.csv”. 
4) Go to “Drift correction” tab. 
5) Choose “Fiducial markers”. Use the following parameters: Max distance: 1000, Min 

marker visibility ratio: 0.1, Trajectory smoothing factor: 0.001. 

 
6) Check “Save to file” and save the file in your folder. 



7) Click “Apply”, then the software will correct the stage drift and save the drift 
information in the folder you choose. You will see the effect of the drift correction in the 
visualization window. Following image shows the position of the gold particle before 
(left) and after (right) the drift correction. The file will be saved in **.json format. 

           
8) Close the current result window, and import your original result (STORM image). 
9) Go to “Drift correction” tab, choose “Load from file”, select the file you saved in step 7, 

then click “Apply”. 

 
10) Drift correction will be done in the image. 

6. Optional: Since there are some artifact (noise) of the image, it is recommended to filter further. 
In “Filter” tab of the ThunderSTORM results window, use “(offset > 1) & (100 < intensity) & 
(intensity < 10000).” 

7. The resulting image will be shown, for example, as below. 

 
Figure 8. STORM image of microtubule. Highlighted area with the white box  is used in Figure 9. 



8. You will be able to show images of regular resolution image and STORM image of the same area. 
An example is below. You can use the images for measuring the width of a filament for lab report 
questions. 

 
Figure 9. Images of microtubule in the white box in Figure 8. Regular (diffraction limited, left) vs. STORM image (middle). The 
plot on the right side is the intensity profile along the white line in the figures. 

 
Lab Report Questions 

1) Fluorescence: Figure on the left side is the absorption and fluorescence emission spectra of 
Alexa647 the fluorescent dye we used for the experiment, right figure is called Jablonski 
diagram which shows possible electronic transitions by photo-excitation. 

 

a. Connect relevant or corresponding process in Jablonski diagram to ⓐ absorption, ⓑ 

fluorescence emission, and ⓒ Stokes shift. 

b. What’s the difference between ③ and ⑤? 
c. In the spectrum plot, why is emission spectrum a (almost) mirror image of absorption 

spectrum? 
2) Questions about the microscope setup. See Figure 5 for the questions. 

a. What is the function and the role of following optical components in the microscopic 
system? 
• Major (essential) components 

i. Laser: 
ii. Dichroic (dichromatic) filter (beam splitter): 

iii. Emission filter: 
iv. Objective lens: 



v. Tube lens: 
vi. Lens 1&2 (Beam expander): 

vii. Lens 3 (as Kohler lens): 
• Minor components 

i. ND filter: 
ii. Diffuser: 

b. You are using f=100 mm lens for Lens 1 & 2. If the Lens 1 is changed to f = 50 mm lens, 
how does it effect on the system? What if Lens 2 is changed to f = 50 mm lens? (The 
location of lens will be matched with its focal length.) 

c. What is the role of tube lens? If you use f = 200 mm lens for the tube lens instead of f = 
100 mm, how does it effect on the image (pixel size of the camera)? 

3) Let’s compare bright field (transmission) microscopy and fluorescence microscopy. 
a. In both the bead and the cell image, what structure can you see? Is the structure visible 

both in brightfield images and fluorescence images? If not, why? 
b. Based on the result, what is the advantage of fluorescence microscopy over 

transmission microscopy? Explain with the concept of signal-to-noise ratio (SNR). 
4) In the images of the fluorescent beads, what is the measured size of the beads? What is the 

actual size of them? If they are different, why? Take a few beads in the image and measure their 
Full-width-half-maximum (FWHM) of Gaussian fit. Also, measure the thickness of microtubule 
filaments in the fluorescence image of the cell in the same way. How think is it? Is the value the 
same as known thickness of the microtubule?  

5) From question 4, how are the results related to the optical resolution of the system? How do 
you define a resolution of the system? How is it related to the diffraction limit of light?  

6) Use the analyzed results of the bead images. Pick one of the beads in the fluorescence image. 
What is the position (e.g. x-y coordinate) of the bead? How accurately can you define its 
position?  

7) You tested different imaging buffer conditions (+/- oxygen scavenger, +/- thiol). How are the 
images different in different conditions? Based on that, what are the roles of oxygen scavenger 
and thiol? How do they help to achieve super-resolution image? 

8) How do you define resolution in STORM imaging? What is the resolution of your image? What is 
the localization accuracy of the fluorophore detected in the image? Answer this with the STORM 
image you have taken in the experiment and the analysis results (e.g. the width of the 
microtubule filament in the image).  

9) For SMLM (Single Molecule Localization Microscopy or STORM), what is the advantage of using 
fluorescence technique? 
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